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Abstract
Current two-dimensional (2D) models have limited biological relevance to the tumor

microenvironment, often failing to replicate the complex cell-cell interactions found in vivo. The
objective of this project is to select a suitable cancer cell line to develop and refine a
three-dimensional (3D) cell culture model that better recapitulates the tumor microenvironment.
Toward this end, A549, a non-small lung cancer line (NSCLC) with mutations to tumor protein
53 and a relative sensitivity to the three main cancer drugs, was cultured and a doubling time of
23 hours was established. An optimal static spheroid formation protocol was engineered and
tested by seeding spheroids with A549s at various densities. BioTek cytation images of thes5e
spheroids were taken and processed using ImageJ and MATLAB. From this data it was
determined that ideal A549 aggregates were formed at a seeding density of 50k-75k.

In the future, the relevance of this information can be applied to scale up spheroid
formation to prepare for γH2AX—a sensitive marker for DNA double-strand breaks (DSBs)—
staining and a high-throughput genome-wide CRISPRi screen. The team will provide valuable
insights that bridges the gap between in vitro studies and clinical applications leading to more
effective cancer therapies and improved patient outcomes.
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1. Introduction
1.1. Motivation and Societal impact

Cancer impacts millions of lives each year, with an estimated 2.2 million new cases and
736,790 deaths reported in the United States in 2024 [1], and not mentioning those still living
with cancer. In the past, using 2D monolayer with CRISPR screening has provided extensive
knowledge on what drives cancer cell high growth rate and what therapeutic treatments they are
susceptible to. However, it fails to accurately represent the 3D tumor environment, leaving out
important factors such as genome stability and DNA damage regulatory genes. Providing a
replicated 3D tumor environment that is compatible with CRISPR screening can help identify
sources of DNA damage not found with 2D cultures. This can lead to early detection, new
therapeutic tools, and possibly genomic therapies.

1.2. Problem Statement
Although previous CRISPR screening in 2D monolayers has provided useful knowledge

on cancer drivers and therapeutic susceptibilities, it lacks an element of biological relevance to
an in vivo environment. Therefore, our team was tasked with developing a cell culture method
that is compatible with a 3D environment and CRISPRi screening in order to identify sources of
DNA mutations in the tumor environment. To achieve this goal, the team must select a viable
cell line for the screen, create and optimize a spheroid formation protocol, and develop a
protocol to stain for γH2AX: a histone variant that is a sensitive marker for DNA damage.

2. Background
2.1. Background Research

2.1.a. 3D spheroids
The study of cancer and its progression has evolved significantly, with advancements in

genetic and molecular biology providing deeper insights into the mechanisms underlying
tumorigenesis. In this context, 3D spheroids have emerged as a superior model compared to
traditional 2D monolayer cultures. 2D cultures are limited in their ability to replicate the
complex cellular interactions and microenvironment characteristic of actual tumors, which can
lead to poor results in drug response and tumor behavior studies [2]. In contrast, 3D spheroids,
composed of cancer cells aggregated in a spherical configuration, better mimic the architecture
and growth phenotypes observed in tumors as seen in Figure 1 [2]. This structural arrangement
facilitates critical cell-cell and cell-matrix interactions, which are essential for maintaining
cellular functions and responses to therapeutic agents [3]. From these interactions, more DNA
damage is observed in 3D spheroid cultures compared to 2D monolayers due to the hypoxic and
nutrient-deprived microenvironment, which generates reactive oxygen species (ROS) and
impairs DNA repair pathways [4]. Consequently, the use of 3D spheroids enhances the fidelity of
experimental models, allowing for a more accurate investigation of tumor structure, cancer
progression, and the efficacy of potential treatments.
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Figure 1: Comparison of 2D versus 3D tissue culture [5].

2.1.b. Cell line
Creating a cancer cell line is a multifaceted process that begins with the collection of

tumor tissue from a cancer patient, typically obtained through biopsy or surgical resection. Once
the tissue is collected, it undergoes processing to isolate individual cancer cells, often involving
enzymatic digestion or mechanical disruption to break down the extracellular matrix and liberate
the cells [6]. These isolated cells are then placed in a nutrient-rich culture medium designed to
support their growth, containing essential nutrients, growth factors, and an appropriate pH. As
the cells proliferate, certain cancer cells may demonstrate faster growth rates; these cells can be
selected for further cultivation. Once cultivated, a cell line is then defined as continuous (infinite)
or finite. For the purposes of this design project, both infinite and finite cell lines have been
considered. After establishing a stable culture, the cell line undergoes thorough characterization
to confirm its cancerous properties, assessing factors such as cell morphology, growth rate, and
genetic markers. Finally, once a stable and well-characterized cell line is established, it is
cryopreserved in liquid nitrogen for long-term storage [7]. The cell lines considered must be able
to display a 3D tumor environment upon spheroid formation, be compatible with CRISPRi
screening, and express γH2AX.
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Figure 2: Cell line creation [6].

2.1.c. CRISPRi Screening
CRISPR interference (CRISPRi) is a powerful tool for gene regulation that allows for the

targeted repression of genes without directly inducing double-strand breaks in the DNA. This
technique utilizes a catalytically inactive Cas9 (dCas9) protein fused to transcriptional
repressors, enabling precise control over gene activity [8]. In this project, lentiviral vectors are
employed to deliver the CRISPRi components into the target human lung cancer cell line, which
is A549. The use of lentivirus is advantageous due to its ability to efficiently transduce a wide
range of dividing and non-dividing cells, ensuring stable expression of the dCas9 and guide RNA
(sgRNA) constructs necessary for effective gene repression [8]. For instance, SOX2 is a
transcription factor associated with stemness and tumor progression in non-small cell lung cancer
(NSCLC). It regulates self-renewal, differentiation, and pluripotency, making it a key driver of
cancer stem cell (CSC) properties. SOX2 is frequently co-expressed with surface markers such
as CD133 and CD44, which are commonly used to identify CSCs. CD133, a marker of
tumorigenicity, is often upregulated in SOX2-expressing cells and is linked to enhanced
self-renewal and tumor initiation [9]. Similarly, CD44, which plays a role in cell adhesion and
migration, is associated with SOX2 in promoting metastasis and resistance to therapies [9].
These surface markers, in conjunction with SOX2, delineate a subpopulation of CSCs that
contribute to lung cancer progression, recurrence, and therapeutic resistance, making them a
target for gene therapies in NSCLC.

By applying CRISPRi in a 3D spheroid model, the team's design aims to better mimic the
in vivo environment for the screen, which is essential for understanding the complex interactions
that drive cancer progression and treatment resistance. As stated, this approach facilitates the
identification of gene targets that contribute to DNA damage responses and cellular survival in a
more physiologically relevant context compared to traditional 2D cultures.
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2.1.d. 𝛾H2AX
γH2AX is a phosphorylated variant of the histone H2AX, which serves as a sensitive

marker for DNA double-strand breaks (DSBs) [2]. The phosphorylation of H2AX occurs rapidly
in response to DNA damage, making it an essential marker for monitoring the integrity of the
genome [3]. In cancer research, γH2AX staining is utilized to assess the extent of DNA damage
and the efficacy of DNA repair mechanisms.

γH2AX allows for the quantification of DNA damage induced by various genetic
suppression within the 3D spheroid model. γH2AX staining is more challenging in a 3D
environment due to the compact and multilayered structure of spheroids creating physical
barriers that hinder the diffusion of antibodies into the inner core. This lack of uniform antibody
penetration can result in incomplete staining, where only the outer layers of the spheroid are
adequately labeled, leading to a skewed representation of DNA damage throughout the entire
structure.

If the γH2AX staining is done correctly in a CRISPRi screen within 3D spheroids, it
enables accurate assessment of DNA damage across the entire structure, including inner cell
layers, providing a comprehensive view of the effects of gene knockdowns on genome stability.
This ensures that the screening results are not biased toward cells in the outer layers and allows
for the identification of key genetic contributors to DNA repair and damage pathways in 3D. The
response of dsDNA breaks can effectively evaluate how specific gene targets contribute to
genomic stability, tumor biology, cancer progression, and therapeutic vulnerabilities.

It is important to choose a cell line that has been proven to be sensitive (or has a baseline
of sensitivity) to DNA damage for successful γH2AX staining. One way to determine this
criteria is to see whether that cell line is sensitive to drugs that can induce DNA damage. The
drugs chosen for this purpose include cisplatin, oxaliplatin, and bleomycin.

Cisplatin is a platinum-based chemotherapeutic agent widely used in the treatment of
various solid tumors, including lung, ovarian, and bladder cancers. Its mechanism involves the
formation of DNA cross-links, which interfere with DNA replication and transcription, leading
to cell cycle arrest and apoptosis [10]. Another platinum-based compound with similar
anticancer mechanisms is oxaliplatin, which is more effective in some forms of cancer such as
colorectal cancer [11]. On the other hand, bleomycin, an antitumor antibiotic, induces DNA
damage through the generation of free radicals, leading to both single and double-strand DNA
breaks. Unlike platinum-based drugs, bleomycin’s mechanism of action makes it suitable for
combination therapy, targeting cancer cells through a different pathway [12].

Drug sensitivity is quantitatively measured by Z-score, which measures drug sensitivity
of a specific cell line to a specific drug in comparison to other cell lines. Negative Z-scores
reflect sensitivity, with lower values indicating greater susceptibility to the drug’s cytotoxic
effects, while positive Z-scores indicate resistance [13]. A Z-Score of +1 is considered
significant [14]. These differential responses across cancer types and drug classes highlight the
complexity of cancer treatment and the need for tailored therapeutic approaches based on
specific tumor characteristics.
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2.1.e. Previous Literature
In previous research, 3D cancer spheroid models have been utilized for CRISPR-Cas9

screens with and without using an exogenous extracellular matrix (ECM).
Takahashi et al, 2020 utilized 4% Matrigel, an ECM based approach, as bio-scaffolding

to plate A549 cell spheroids. They concluded that their seeded spheroid models in-vivo
interactions between cells and the ECM were more biologically relevant than former 2D studies
[15]. The study’s CRISPRi library gene list as well as its phenotypes have a strong overlap with
those from Han et al, 2020, suggesting that inner cells of ECM-based 3D spheroids may be
similar to ECM-free 3D spheroids.

Han et al, 2020 devised an ECM-free scalable method to propagate 3D spheroids [16].
H23 cells were seeded on pre-treated ultra-low attachment or poly-HEMA-covered plates in
RPMI 1640 medium with 0.75% methylcellulose. Similar methods have been found to be
implemented in other studies, such as by Ferrarone, et al (2024) and by Stiff, et al (2024) [17],
[18]. A total of around 210,000 single guide RNAs (sgRNAs) were designed for the CRISPRi
library with around 10 sgRNAs per gene [16]. Samples were used to calculate growth and/or
tested for drug resistance [16].

3D stem cell models have also been genomically edited via CRISPR-Cas9 to better
model various disease phenotypes. Cells can be assembled with or without supporting scaffolds.
Some example scaffolds include laminin-rich Matrigel, collagen matrix, or those that are
naturally derived from decellularized tissues [19].

2.2. Client Information
The clients, Ms. Carley Schwartz and Dr. Gaelen Hess are researchers at the Hess

Laboratory within the Wisconsin Institutes for Medical Research (WIMR). The group’s research
focus is on high-throughput functional genomics to investigate DNA repair and pathogenic
effectors [20]. Dr. Hess is an assistant professor in the Department of Biomolecular Chemistry
and Center for Human Genomics and Precision Medicine [20]. Ms. Carley Schwartz is the lab
manager and a research intern at the Hess Laboratory.

2.3. Design Specifications
The project aims to develop a 3D cell culture method compatible with CRISPRi

screening to identify sources of DNA mutations in tumors, utilizing γH2AX as a marker for
DNA damage. The client requires the team to select an appropriate human lung cancer cell line,
to which A549 and NCI-H23 meet that criteria [21]. This protocol must focus on optimal seeding
density, targeted at 50,000 cells/cm², and viscosity adjustments through methylcellulose to ensure
uniform spheroid size and maximal cell growth [16]. Additionally, a γH2AX staining protocol
needs to be established following the guidelines of scalability, and be reproducible with
optimized antibody concentrations and reagent volumes.
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With the use of human contaminants, safety measures are to adhere to all Biosafety Level
2 (BSL-2) standards, implementing containment protocols and proper waste disposal [22]. The
accuracy and reliability of the spheroid formation process will be monitored through live-cell
imaging to confirm a ~30% cell death rate, and at least three staining experiments will be
conducted to establish statistical confidence in the results.

For life in service, cells will require approximately two months in culture for protocol
optimization, spheroid formation following the culture, and a minimum of six days post-infection
with the CRISPRi library. To ensure long-term viability, cells will be cryopreserved at
temperatures below -135°C. Operating conditions will be maintained at 37°C, 5% CO₂, and
90–95% humidity [23].

The design will prioritize ergonomic efficiency in the experimental setup, aiming to
enhance throughput while accurately mimicking in vivo conditions. Spheroids are targeted to be
~500 µm in diameter, and accurate assessments of mass and density will be facilitated through
specialized equipment [24]. The project budget is capped at $1,000, with a focus on utilizing
existing lab materials to keep costs manageable.

Lastly, the team will conduct a competitive analysis of existing 3D cancer models,
focusing on methodologies that incorporate ECM-free approaches. Key milestones include cell
line creation and protocol development by October 2024, optimization of spheroid formation by
November 2024, completion of the γH2AX staining protocol by December 2024, execution of
high-throughput CRISPR screening by February 2025, followed by analysis of phenotypic
differences before May 2025. For more detailed information see Appendix 12.1.

3. Preliminary Designs
3.1. Cell Lines

3.1.a. NCI-H23
NCI-H23 is an epithelial-like cell that was isolated from the lung of a Black, 51-year-old,

male patient with adenocarcinoma. H23 is a non-small cell lung cancer (NSCLC) with a
doubling time 38 hours [25]. Although H23 is considered an adherent cell line, it is known to
have weaker cell-cell interactions due to the lack of E-cadherin at the cell membrane [26]. H23
exhibits TP53, KRAS-12, epidermal growth factor receptor (EGFR), L-dopa
decarboxylase-negative, and a high degree of c-myc DNA amplification (20-fold) but no
detectable amplification of c-myc RNA [25]. Additionally, these cells have a reported colony
forming efficiency of 9.7% in soft agarose [2]. H23 is very sensitive to bleomycin (Z-score
average of -1.22), somewhat sensitive to cisplatin (-0.73), and somewhat resistant to oxaliplatin
(+0.41) [27]. One vial of these cells from ATCC is $555.00 [25].

3.1.b. A549
A549 is an adherent cell line isolated from the lung tissue of a White, 58-year-old male

with lung cancer [28]. This NSCLC adenocarcinoma has a doubling time of 22 hours [28]. A549
exhibits mutations for TP53, EGFR, PIK3CA, ALK, and PTEN [29]. A549 is very sensitive to
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bleomycin (Z-score average of -1.04), somewhat sensitive to cisplatin ( -0.12), and very sensitive
to oxaliplatin (-1.45) . One vial of these cells from ATCC is $555.00 [28].

3.1.c. OVCAR-5
OVCAR-5 is a cell line established from ascites fluid from a 67 year old, female,

non-treated patient with a metastatic gastrointestinal cancer that has presented as advanced-stage
ovarian carcinoma [30]. The doubling time for this cell line is 27 hours [31]. OVCAR-5
expresses mutations for KRAS-12, EGFR, and CLAUDIN-4 [30]. This ovarian cancer cell line is
somewhat resistant to bleomycin (Z-score average of +0.67), somewhat resistant to cisplatin
(+0.52), and somewhat sensitive to oxaliplatin (-0.18) [32]. This cell line is not currently
available for the team to purchase [30], [33].

3.2. Spheroid Formation Protocol
3.2.a. Treated Tissue Culture Plates
Treated tissue cultures method is a scaffold-free method [34]. It uses low attachment

plates, which are coated with a hydrophilic polymer (such as hydrogel or poly-HEMA) to
prevent specific and nonspecific cell adhesion to the culture vessel [34]. Thus, high cell-to-cell
interactions allow cells to cluster together, form cell aggregates and eventually into 3D spheroids
(Figure 3) [35]. The number and size of spheroids formed depend on the shape of the wells, with
U-bottom wells creating a single and well-defined spheroid for each well (Figure 3) [35]. The
whole process usually takes up to 4 days [35].

Figure 3: Spheroid formation by treated tissue culture plates/low attachment plates with
U-bottom wells (left) and flat-bottom (right) [34].
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3.2.b. Hanging Drop
Similar to the treated tissue cultures method, the hanging drop method is also

anchorage-independent [34]. Currently, two methods to form hanging drops exist. The first
method is the traditional method, involving dispensing small amounts of cell suspension on a
surface, usually the underside of a petri dish, then flipping the dish upside down to form hanging
drops (Figure 4) [36]. However, this method has a high risk of droplet fusion (if space is limited),
loss of droplet shape (because of frequent media change), and droplet evaporation [37], [38]. The
second method using hanging drop plates negates these risks [38]. Each plate consists of a lid to
maintain sterility and a main component, which has a water reservoir to prevent evaporation and
access holes on top where cells can be added to form hanging drops on the bottom (Figure 5a)
[38]. Hanging drops create a flexible spheroid cell-to-liquid interface, allowing cells to
gravitationally aggregate and form because of high cell-to-cell interactions (Figure 5b) [34]. The
whole process usually takes up to 4 days [35].

Figure 4: Spheroid formation by flipped hanging drop method [36].
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Figure 5: Spheroid formation by hanging drop plate [34].
a. Composition of a hanging drop plate, b. Spheroid formation.

3.2.c. Matrigel
The Matrigel method is a scaffold-dependent method [34]. Cells are cultured in low

attachment plates for 4 days to form aggregates, then Matrigel is added to encourage
cell-to-ECM interactions which will form spheroids after another 2 days (Figure 6) [39].

Figure 6: Comparison of single 3D spheroids grown without and with Matrigel [40].
Green indicates live cells and red indicates dead cells.
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4. Preliminary Design Evaluation
4.1. Design Matrix for Cell Line

Table 1. Design matrix for Cell Line.

Design
Criteria
(weight)

NCI-H23 A549 OVCAR-5

Score
X/5

Weighted
score

Score
X/5

Weighted score Score
X/5

Weighted score

Viability (20) 4 16 5 20 3 12

Adhesion (20) 3 12 4 16 4 16

Reproduction
Speed (20)

3 12 5 20 4 16

Drug
Sensitivity (15)

4 12 5 15 3 9

Genetic
Mutation (15)

5 15 3 9 2 6

Ease of
Procurement
(10)

5 10 5 10 5 10

Total Score
(100)

77 90 69

Determination of Criteria and Weights & Justification of Assigned Scores: After discussion
about the important criteria to evaluate the initial designs against our Product Design
Specifications, the following categories were chosen.

Viability (20):
Cell viability is a measure of the proportion of live, healthy cells within a population

[41]. For this category, viability is a measure of how robust the cell is and how well it can
withstand various stresses. The highest ranked cell line is predicted to be the healthiest after fluid
shear stress, transduction, and cisplatin treatment.

NCI-H23 cells were assigned a score of 4/5 for its and >20% cell death after 72 hours
when subjected to [3 μM] of cisplatin and its sensitivity to cisplatin treatment [42]. The NCI H23
cell line showed a higher expression level of DNA repair proteins after cisplatin treatment
compared to A549 cells. In previous experiments for both NCI-H23 and A549, a negative
correlation between cell viability and DNA damage induction upon cisplatin treatment has been
noted [42]. A549 cells were assigned a score of 5/5 for its >20% cell death after 72 hours when
subjected to [3 μM] of cisplatin and its greater resistance to cisplatin treatment compared to
NCI-H23 cells [42]. OVCAR-5 scored a 3/5 for its severe morphological changes (decreased
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spheroid-forming capacity, reduced cytoskeleton organization, and chromosomal instability)
after exposure to <1 dyne/cm2 fluid shear stress and >50% cell death after 72 hours when
subjected to [2.5 μM] cisplatin [43], [44].

The type of transduction done to these three cell types may either help or hinder the cell
health depending on the transduction virus used (lentivirus or siRNA)and what it is used in
conjunction with (Nrf2, cisplatin, or both). The trend in scientific literature indicates that these
three cell types have the same viability, within 7±3%, when transfected under the same
conditions [42], [43], [44]. Since the vectors encoding the components necessary for
CRISPR/Cas are large, they result in low transduction efficiency and cell viability [45]. To
overcome those obstacles, the team can add exogenous small plasmids that increase transduction
efficiency up to 40-fold and cell viability up to 6-fold [45].

Adhesion (20):
This criteria refers to the ability of cells to attach to the surface of the culture vessel or

substrate they are grown in, as well as to attach to other cells. For this criteria, cell lines were
therefore judged on whether they were considered an adherent cell line and on their strength of
cell-cell interactions. Because adhesion is an important factor in cells being able to effectively
form spheroids, this criteria was given a high weight for scoring.

Although NCI-H23 is considered an adherent cell line [25], it is known to have weaker
cell-cell interactions due to the lack of E-cadherin at the cell membrane [46]. Additionally,
NCI-H23 has presented difficulty in forming spheroids in previous literature, particularly using
the Matrigel method [26]. For these reasons, NCI-H23 scored 3/5. Similarly, although A549 and
OVCAR-5 are considered adherent cell lines [28], [47], [48], it is also known to have a lack of
E-cadherin and thus weaker cell-cell interactions [46], [49]; thus, A549 and OVCAR-5 scored
4/5.

Reproduction Speed (20):
Reproduction Speed is the time it takes the cells to grow and reproduce. In order to look

specifically at the cell line, and exclude any factors caused by the spheroid formation protocol,
the team used the cell lines’ doubling speed. The doubling speed is the amount of time it takes
for a cell population to double in number. Essentially, it is how quickly a cell line replicates itself
in culture [50].

As each cell line has a range of doubling times depending on the culture medium used,
the most typical doubling times were used to determine this category's score. With the longest
doubling time of about 38 hours [25], [51], NCI-H23 scored the lowest at a 3/5. A549 is the
fastest of the three cell lines with a typical doubling time of about 22 hours [28], [51], scoring a
4/5. Lastly, OVCAR5 has a doubling time of 27 hours [31], [51] scoring a 4/5.

Drug Sensitivity (15):
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Gamma-H2AX foci staining is used for this project to assess the extent of
CRISPR-Cas9-based DNA damage. Cell lines that are particularly sensitive to drugs that induce
DNA damage will have a baseline of DNA damage to refer to, making them appropriate for this
project.

Z-scores for NCI-H23, A549, and OVCAR-5 are obtained from the Genomics of Drug
Sensitivity in Cancer Project [52]. NCI-H23 has a Z-score average of -1.22 for bleomycin, -0.73
for cisplatin and +0.41 for oxaliplatin [27]. A549 has a Z-score average of -1.04 for bleomycin,
-0.12 for cisplatin, and -1.45 for oxaliplatin [53]. OVCAR-5 has a Z-score average of +0.67 for
bleomycin, +0.52 for cisplatin, and -0.18 for oxaliplatin [32]. A549 has 2 significant negative
Z-scores, scoring a 5/5. NCI-H23 has a negative Z-score for 1 of the drugs, scoring a 4/5.
OVCAR-5 has none, scoring a 3/5.

Genetic Mutation (15):
Analysis of genetic mutations inherent to various cell lines is crucial in determining the

ideal cell line for our project. A high score in this category means genetic mutations that are
helpful must work with for any step in the adhesion process, Cas9 attachment, CRISPR edit, or
screen. Using Han’s ten selected lung cancer cell lines, a set of ideal cell line mutations were
created including: TP53 (tumor protein p53), a gene that encodes a tumor suppressor protein
containing transcriptional activation, DNA binding, and oligomerization domains [54]; EGFR, a
cell surface protein that binds to epidermal growth factor leading to cell proliferation [55]; and
KRAS, Kirsten rat sarcoma viral oncogene homolog causes malignancies based on an error
encoding a protein that is a member of the small GTPase superfamily [56]. These mutations may
either cause or enhance the malignancy of existing cancer cells. Since TP53 is the most
frequently mutated gene in human cancer, the presence of this mutation is crucial for biological
relevance to half of all cancer cases [57].

NCI-H23 has all of the key mutations including TP53, KRAS, EGFR, a high degree of
c-myc DNA amplification, and no counterproductive mutations, so it was given the highest score
of 5/5 [25]. A549 scored second highest with 3/5 because it contains EGFR and TP53 which are
key, but also PIK3CA, ALK, and PTEN which aren't key but won’t impede the success of the
project [29]. The protein encoded by PIK3CA, phosphatidylinositol 3-kinase, is oncogenic and
represents the catalytic subunit, which uses ATP to phosphorylate PtdIns, PtdIns4P and
PtdIns(4,5)P2 [58]. ALK, anaplastic lymphoma receptor tyrosine kinase, a chromosomal
rearrangement which results in creation of multiple fusion genes in tumorigenesis. PTEN guards
the genome by controlling multiple processes of chromosome inheritance [59]. Although
OVCAR-5 has KRAS, a key mutation, it was ranked the lowest at 2/5 due to the lack of essential
protein TP53 and the presence of additional mutation CLDN4, which is a mutation of integral
membrane proteins [30], [60], [61].
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Ease of Procurement (10):
This criteria assesses how easy it is to obtain the cell line. It is expensive to purchase an

entirely new cell line from ATCC, Sigma-Aldrich or similar sources. Therefore, the chosen cell
line should be either already available in Hess Lab or can be obtained from other labs, preferably
within Wisconsin Institutes for Medical Research (WIMR); however, that process can be
time-consuming.

All 3 chosen cell lines are readily available in Hess Lab, both wild-type and
genetically-modified, and therefore all scored a 5/5.

4.2. Design Matrix for Spheroid Formation
Table 2. Design matrix for Spheroid formation.

Design
Criteria
(weight)

Treated Tissue Culture
Plates Hanging Drop Matrigel

Score
X/5

Weighted
score

Score
X/5

Weighted
score

Score
X/5

Weighted
score

Ease of
Fabrication
(30)

5 30 4 24 3 18

Scalability
(20)

4 16 3 12 5 20

Uniform
properties
(20)

4 16 3 12 2 8

Cost (15) 3 9 4 12 2 6

Safety (15) 5 15 5 15 5 15

Total Score
(100)

86 75 67

Determination of Criteria and Weights & Justification of Assigned Scores: After discussion
about the important criteria to evaluate the initial designs against our Product Design
Specifications, the following categories were chosen.

Ease of Fabrication (30):
This criteria assesses the complexity of the 3D spheroid formation protocol, which is one

of the important factors when choosing an appropriate fit-for-purpose 3D culture model [62].
Specifically, this criteria assesses whether additional specialized training or equipment will be
needed for the protocol, on top of those necessary for 2D traditional cell culture methods. Also,
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the time needed to complete the protocol once will also be considered, as it can directly affect the
length of the project due to the large number of cells needed for genome-wide CRISPR
screening.

Treated tissue culture plates method scores a 5/5 as the cell seeding method is not
particularly labor-intensive, only requires 1 media change and takes the least time (up to 4 days).
Hanging drop method also takes the same amount of time but the cell seeding method requires
more careful technique to ensure hanging drop viability and daily media change, thus scoring a
4/5. The Matrigel method does not require extensive cell seeding technique and daily media
change but requires longer time (6 days), scoring a 3/5.

Scalability (20):
This criteria assesses the plausibility to use these methods to generate a large amount of

viable spheroids. A high-throughput method is preferred because, per the client, each CRISPR
screen would require 100-150 million cells per replicate to generate a sufficient amount of
spheroids [16]. Because a high-throughput method is very important to successfully completing a
spheroid CRISPR screen, this criteria was given a high weight for scoring.

The treated tissue culture plates method is known for its high-throughput capabilities
because treated plates have a non-adherent coating that promotes rapid cell aggregation into
spheroids [63]. This method also allows for a greater amount of spheroids to be made in a single
plate because it can accommodate large volumes of media [64]. For these reasons, this method
was given a score of 4/5 for scalability. The Hanging Drop method, in contrast, is considered to
be low-throughput in nature. One reason for this is because the method requires a lot of manual
handling and is prone to error when setting up and transferring the drops [65]. Additionally,
scalability is limited with the Hanging Drop method because each tissue culture plate can only
hold a limited amount of drops, and each drop only tends to form one spheroid [37]. For these
reasons, this method was given a score of 3/5 for scalability. Lastly, the Matrigel method is
considered high-throughput because, like the treated tissue culture plates method, it can allow for
a comparatively larger volume of media to generate spheroids compared to the Hanging Drop
method. Additionally, this method involves polymerizing a layer of Matrigel matrix onto tissue
culture plates to promote spheroid formation [26], and unlike the other two methods, has been
shown to improve the growing environment of spheroids due to its mimicry of in-vivo tumor
conditions [40]. For these reasons, this method was given a score of 5/5 for scalability.

Uniform Properties (20):
This criteria outlines the reliability of the spheroid formation to produce uniform

properties. The ideal formation protocol has no batch-to-batch variability. Minimal variation in
size, shape, and porosity is expected so the experiment will have a higher chance of
reproducibility and fewer outliers. It is important to note that research has shown that differences
in spheroid formation arise from the differences in cell-biomaterial interactions rather than due to
differences in cell viability or proliferation [66].
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The treated tissue culture plates scored the highest in this category, 4/5, due to their
minimal variation between batches. Additionally, treated tissue culture plates have a larger
amount of spheroids per batch (see Scalability section), making it easier to harvest a uniform size
or shape [62]. Due to the low-throughput nature of Hanging Drop, making it harder to harvest
uniform spheroids, and due to its 10% to 15% size variation between drops, this method scored a
3/5 [67]. Matrigel, animal-based basement membrane extract, has a batch-to-batch variation that
can hinder reproducibility, so a score of 2/5 was assigned to it [66]. Cells seeded in matrigel also
tend to form large cell aggregates with looser morphology rather than spheroids with round,
regular shape [66].

Cost (15):
This category is scored based on the expenses of the materials needed to perform the

spheroid formation protocol. While the client stressed the importance of a working protocol they
also expressed their desire to keep costs to a minimum, as to be able to repeat the protocol and
perform it on a larger scale.
Explain scoring:

Treated tissue culture plates scored a 3/5 in this category. Generally, the culture plates
range from $0.22-3.78 per well [68], with a need for an abundance of wells. The cost of treated
tissue culture plates can vary depending on the manufacturer, the number of wells needed, and
the volume of cell culture media required. The Hanging Drop method is rather inexpensive as it
does not require specialized equipment or reagents. At around $4 [69], [70] per 100 mm plate the
Hanging Drop method is the most cost effective method out of all the options and scored a 4/5
[71]. Lastly, Matrigel scored a 2/5 in this category as the Matrigel itself is rather expensive, at
$380 for 10 mL of Matrigel [66], [72].

Safety (15):
This criteria assesses the ability of the method to be used in a laboratory environment

without posing significant health risks to the user or the experimental results. This includes
evaluating the potential hazards associated with the materials/reagents and processes used, the
ease of handling, and the effectiveness of protective measures (e.g., PPE, ventilation). A method
should be dependable, minimizing the risk of contamination or adverse effects that could
compromise the safety of the personnel and the integrity of the experiments.

All of the methods proposed were able to obtain a 5. This is due to none of the methods
using harmful reagents in the process of fabrication. All of the cell lines pose similar
contamination risk but can be lowered considerably with proper PPE use.

4.3. Proposed Final Design
A549 was the cell line selected based on the team’s decision matrix (Table 1). A549 is an

adherent cell line which exhibits the most useful mutations (EGFR, TP53, PIK3CA, ALK, and
PTEN) [28], [29]. Since this cell line has a doubling time of approximately 22 hours, the team
will need to passage the cells 2-3 times a week [73]. Hess lab recommends a maximum of 20
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passages be done on each cell line, so, once thawed, each cell line will have approximately 7
weeks before it must be bleached and another cell line thawed [73].

Treated tissue culture plates, or low attachment plates method was the selected spheroid
formation protocol selected based on the team’s decision matrix (Table 2). The process includes
using hydrophilic polymer-coated plates [34], which are not labor intensive to make, and
spheroid formation takes around 4 days [35], which is not time-consuming. Furthermore, as this
method does not require a scaffold, it does not run the risk of high batch-to-batch variability due
to using animal-derived matrices [34].

5. Design Process
5.1. Doubling time

5.1.a. Calculations used
See Appendices 12.2 and 12.3 for the full cell line maintenance and passaging
protocols. Doubling time of cultured A549 cells was determined based on a
Monday-Wednesday-Friday passaging schedule using equation 1 below:

Equation 1. Equation for calculating a cell line’s doubling time. doubling time (days) and µ𝑡
𝑑

=

= growth rate (1/day). µ was obtained from the CytoFLEX cell confluency reading [74].

Once doubling time was determined, the volume of cells to passage was calculated
using equation 2 below:

# 𝑐𝑒𝑙𝑙𝑠 𝑖𝑛 𝑐𝑢𝑙𝑡𝑢𝑟𝑒 𝑠𝑜𝑙𝑢𝑡𝑖𝑜𝑛
10 𝑚𝐿 = # 𝑐𝑒𝑙𝑙𝑠 𝑛𝑒𝑒𝑑𝑒𝑑 𝑡𝑜 𝑝𝑎𝑠𝑠𝑎𝑔𝑒

𝑣𝑜𝑙𝑢𝑚𝑒 𝑛𝑒𝑒𝑑𝑒𝑑 𝑡𝑜 𝑝𝑎𝑠𝑠𝑎𝑔𝑒

Equation 2. Equation for calculating the required volume for passaging. The number of cells
needed to passage was estimated by looking at previous passage values and their resulting

doubling times.

5.1.b. CytoFLEX Protocol
Comprehensive CytoFLEX protocol can be found below and in Appendix 12.3. Briefly,

ensure daily clean has been run, load a well vortexed sample, alter settings to fast, click run, auto
set axes from properties menu, gate a representative live cell population, and save file to BME
team folder.

5.1.c. Final established doubling time
The cultured A549 cells’ average established doubling time (for cells derived from

second cryovial thawed) was 43.94 hours. When cutting down to 1.75 million cells for a two-day
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passaging period (Monday to Wednesday; Wednesday to Friday), the doubling time was closer to
the doubling time of 22 hours observed in literature [28], averaging at 22.93 hours. However,
when cutting down to below 1.75 million cells for a 3-day passaging period (Friday to Monday)
the doubling time was much higher, averaging at 52.95 hours. It is also important to note that
there was significant variability in measured doubling times with cells derived from the first
cryovial of the semester, with some doubling times reaching up to 72 hours. A suspected reason
for this variability was that step 8) in Appendix 12.3 was not followed consistently by all team
members. This likely caused the CytoFLEX cell confluency reading to be underestimated for
these passages and, as a result, the doubling times to be higher than expected. See Appendix 12.4
for the cell line maintenance benchling data.

5.2. Spheroid Protocol Selection
Once treated tissue culture plates were selected for our fabrication method, additional

research was done to compare the client’s spheroid formation protocol to protocols from other
literature (section 2.1e). With the client’s assistance, the selection of techniques was narrowed
down to K. Han et al. and J. R. Ferrarone et al.. Both protocols were fairly similar in terms of
complexity and required materials, but differed greatly in terms of time and scalability (table 3).
Overall, a modified version of K. Han et al. was used for preliminary spheroid formation and
seeding density testing. The main modifications made include using DMEM + 10% Fetal Bovine
Serum (FBS) and 1% penicillin-streptomycin rather than the RPMI, using different TC plates,
different poly-HEMA and Methylcellulose preparation methods, and exact seeding density. K.
Han et al. used RPMI to prevent excessive aggregation of cells in the spheroid, but that should
not be a concern for the team in this early testing phase. Other alterations made to the protocols
will be discussed in the testing and discussion sections respectively. Deciding on an exact
preliminary protocol to follow was essential for materials selection and ordering.

Table 3. Additional design matrix for spheroid formation protocols.

Design Criteria 1: K. Han et al. 2: J. R. Ferrarone et al.

Cost Medium Low

Spheroid Formation
Time

Overnight* 24 hours

Scalability
-cells/spheroid
-spheroid #

20k-150k cells/cm2 1k cells/well

Required machinery
& materials

1) 500uL media containing
0.75% methylcellulose
2)RPMI 1640 growth medium
3)96-well poly-HEMA TC plates

1) 80 µL of
methylcellulose-containing medium
4)RPMI
5) V-bottom 96-well plates
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(low-attachment)
*time does not include Methylcellulose, poly-HEMA, media, or plate preparation.

6. Methods
6.1. Materials

Materials listed are required for culturing and passaging A549 cells and are already
available in Hess Lab and thus require no purchasing. One 1 mL cryovial of A549 can be used
up to 20 passages and 3 passages will be performed for each week of the project. In total, two
cryovials of A549 were used, and a total of 20 passages (15 for the first cryovial and 5 for the
second) were performed.

Table 4. Materials List.

Material Part Specification Quantity Price

Already available in Hess Lab, requires no purchasing

T-75 Flasks Catalog #156800 -
Thermo Fisher Scientific

1 for up to 20
passages

$381.65 / case of 100
[75]

A549 CCL-185 - ATCC N/A $555 / vial [28]

DMEM (high
glucose)

Catalog #11965118 -
Thermo Fisher Scientific

1x500 mL bottle
10 mL / passage
(used in solution
with Pen/Strep and
FBS)

$264.65 / 10 x 500 mL
[76]

Penicillin-
streptomycin
(Pen/Strep)

Catalog #15070063 -
Thermo Fisher Scientific

1% in solution with
DMEM and FBS

$23.65 / 100 mL of
5,000 U/mL [77]

Fetal Bovine
Serum
(FBS),Value

Catalog #A5256701 -
Thermo Fisher Scientific

10% in solution
with DMEM and
Pen/Strep

$314.37 / 500 mL [78]

PBS, pH 7.4 Catalog #10010072 -
Thermo Fisher Scientific

2 mL / passage $244.00 / 6 x 1000 mL
[79]

Trypsin-EDTA
(0.05%), phenol
red

Catalog #25300120 -
Thermo Fisher Scientific

3 mL / passage $287.65 / 20 x 100 mL
[69]

VWR®
Flat-bottom
96-well

Catalog #76446-962 -
VWR

2 plates $494.24 / 100 plates
[80]

21

https://www.thermofisher.com/order/catalog/product/156800
https://www.zotero.org/google-docs/?rJuGMb
https://www.zotero.org/google-docs/?Go4U8h
https://www.zotero.org/google-docs/?omlyNG
https://www.zotero.org/google-docs/?2iKji8
https://www.zotero.org/google-docs/?NK5Xwo
https://www.zotero.org/google-docs/?FGkdoB
https://www.zotero.org/google-docs/?oWNad6
https://www.zotero.org/google-docs/?Iy8HCf


polystyrene assay
plates

Ethanol Catalog #BP28184 -
Fisher Scientific

33 mL $1,595.00/ (4 x 4L)
[81]

Requires purchasing

Poly-HEMA Catalog P3932-10G -
SigmaAldrich

1.3 g $238 / 10 g [82]* 1.3 g
= $30.94

Methylcellulose Catalog M0512-100G -
SigmaAldrich

2 g $51.40 / 100 g [83] *
2g = $1.03

Accutase Catalog A1110501 -
ThermoFisher

Has not been used $60.65 / 100 mL [84]

Total: $92.62

6.2. Protocols
6.2.a. Hess Lab Cell Line Maintenance
Thawing Protocol: This protocol is developed by Hess Lab [85]. New media is prepared

in a 15 mL tube. Slowly mix the media in the cryovial to thaw cell pellets. Once thawed, cells are
pelleted by centrifugation and resuspended in fresh media. Cells need to be grown for typically 3
days before passaging further. See Appendix 12.2 for detailed protocol.

Passaging Protocol: This protocol is developed by Hess Lab [85]. This assumes
passaging in a T75 flask (is using a T150, double the volume). Media is removed via aspiration.
Wash cells with PBS then detach cells from the culture vessel with trypsin, then media is
re-added to inactivate the trypsin. Cells are moved to a 15 mL conical tube, pelleted by
centrifugation, and resuspended in new media. Add cell suspension to a new flask and add new
media, enough to cover the cells. See Appendix 12.2 for detailed protocol.

6.2.b. Spheroid formation protocol
Spheroid formation protocol is based on Han et al, 2020 [16]. This semester, cells will be

seeded at multiple densities to determine the optimal density for high spheroid numbers, uniform
spheroid size, and high percent viability (see section 7).

To prepare 2% methylcellulose solution stock, for spheroid formation, 2 g
methylcellulose is dissolved in 100 mL deionized water at 80°C. Then, the solution will be
autoclaved then mixed overnight at 4°C. Solution can be kept at 4°C.

To prepare poly-HEMA stock solution to coat plates, 1.3 g of poly-HEMA is dissolved in
33 mL 99% ethanol by mixing overnight at 37°C. The solution is then filtered through a 0.22 µm
filter and can be stored at room temperature (20°C). To coat plates, 50 µL of poly-HEMA stock
solution is added to each well of a 96-well plate. Plates will be left to dry overnight at room
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temperature in an open tissue culture BSC hood for ventilation, and should be partially-closed
instead of fully-closed. After drying, poly-HEMA-coated plates can be stored at 4°C for up to
one month.

Seed cells at 4 different densities (25k, 50k, 75k, and 150k cells/cm2) in serum-free
DMEM medium containing 0.75% methylcellulose, with 6 wells for each density. FBS is not
added to the growth medium because it will promote cell attachment to the vessel wall and thus
prevent spheroid formation. The methylcellulose will prevent excessive aggregation of cells in
spheroid culture and maintain even spheroid size. Spheroids should be split every 3-4 days, and
can be dissociated into single cells using Accutase (see section 6.2.c) and can be reseeded into
new spheroids. See Appendix 12.2 for detailed protocol.

6.2.c. Spheroid Cell Dissociation
This protocol is based on Honeder et al, 2021 [86] and Han et al, 2020 [16], and it

accounts for dissociation of 6 wells for seeding densities 1-4 (see section 6.2b). Spheroids can be
dissociated after 3-4 days, and dissociated cells can be used to form new spheroids to determine
the percent viability (see section 7.2). Firstly, 24 1.5 mL Eppendorf tubes are prepared and
labeled accordingly, with 6 tubes for each seeding density group. Seeded contents from each well
are transferred into their corresponding Eppendorf tubes and diluted with 480 µL PBS. Spheroids
are collected via centrifugation at 800g for 15 min, and resuspended in 150 µL Accutase.
Spheroids are incubated at 37°C for 10 minutes, and 850 µL serum-free DMEM is added to bring
the final volume to 1 mL. See Appendix 12.7 for full protocol.

6.2.d. Lentiviral infection protocol
This protocol was developed by Hess Lab [87]. First, one should count and plate the

number of cells listed above for each infection in a well of a 24-well plate (see Appendix 12.9).
After filtering with a 0.45µm filter, 1-2 mL of virus(es) are added to each well and left to
incubate for 24 hours at 37°C. After incubating, viral media is aspirated from each well and
replaced with 1 mL of proper media. 48-72 hours later, the cells should be ready for analysis by
fluorescence or selection with antibiotics. See Appendix 12.9 for detailed protocol.

6.2.e. High-throughput CRISPRi screen protocol
High-throughput, pooled CRISPRi-dCas9 loss-of-function screening protocol is based on

Mathiowetz et al, 2023 [88] and may be modified to better suit this project’s needs. Constitutive
Cas9-expressing cells are first generated through lentiviral transduction. A dose response
analysis is then performed to determine the concentration of cytotoxic compounds. For antibiotic
selection, this analysis can either be a drug-resistance screen or a drug-sensitivity screen. Next,
the dynamic range of the reporter for fluorescence-based assays is determined (aim for a greater
distance between high and low fluorescence intensity bins). The sgRNA library is prepared,
either by amplification and packaging into lentivirus or purchased as pre-packaged in lentivirus.
The sgRNA is introduced via lentiviral transduction (note: this step can be done either together
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or separately from the Cas-9 introduction step). sgRNAs present in each cell population are then
identified by extracting genomic DNA (gDNA) from frozen cell pellets and amplified by
polymerase chain reaction (PCR). The pooled sgRNA library is sent for deep sequencing and
readings are analyzed using casTLE. See Appendix 12.10 for detailed protocol.

6.3. Final Prototype
6.3.a. A549
A549 is an adherent cell line isolated from the lung tissue of a White, 58-year-old male

with lung cancer [28]. This NSCLC adenocarcinoma has a doubling time of 22 hours [28]. A549
exhibits mutations for TP53, EGFR, PIK3CA, ALK, and PTEN [27]. Since TP53 is the most
frequently mutated gene in human cancer, the presence of this mutation is crucial for biological
relevance to half of all cancer cases [57]. A549 is very sensitive to bleomycin (Z-score average
of -1.04), somewhat sensitive to cisplatin (-0.12), and very sensitive to oxaliplatin (-1.45) [27],
[32], [53]. Although one vial of these cells from ATCC is $555.00, Hess lab provided 2 vials for
this project [28]. Due to their 50 µm cell diameter, confluency in a T-75 flask was defined as
5,000,000 cells/10 mL.

Figure 7: 10x Brightfield image of A549 Passage 5 cells taken at 200% confluency.

6.3.b. Poly-HEMA Plates
For full poly-HEMA stock solution plate preparation see Appendix 12.5.b. Briefly, add

poly-HEMA to 99% ethanol, mix solution overnight at 37°C, filter solution into a glass bottle,
and keep solution at room temperature until needed.

6.3.c. Spheroid Formation Protocol
For full materials and protocol see Appendix 12.5. Briefly, prepare methylcellulose stock

solution, seed cells at multiple densities ranging from 200,000-150,000 cells/cm² (with 500 μL
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growth medium/cm²) in Poly-HEMA coated 96-well VWR plate, centrifuge spheroids, and leave
in incubator for 3-4 days.

7. Testing
7.1. BioTek Cytation Imaging

In summary, Open BioTek Gen5 3.14 application, place plate in BioTek with A1 well in
on the bottom right of the holder like pictured in Appendix 12.6, select new experiment and new
protocol making sure that the experiments and photos are saved in the same location and
transferred together otherwise both will be lost, set protocol and imaging settings, and click run.

7.2. Percent Viability after Spheroid Formation Determination
The purpose of a spheroid cell dissociation experiment is to determine percent cell

viability across seeding densities 1-4. Results from this experiment were meant to inform future
percent live/dead experiments using mCherry for alive cells and Sytox Green for dead cells, with
the aim to determine the seeding density showing a ~30% peak cell death rate during the initial
growth phase of the spheroids [16]. Although this experiment was delayed to next semester due
to an unforeseen maintenance issue with the Hess Lab’s flow cytometry equipment, the protocol
is outlined briefly here. After 1 mL of dissociated cells are obtained (see section 6.2.c), the
cellular concentration and number of live and dead cells are counted using the CytoFLEX. The
percent cell viability can be determined by comparing the number of live cells to the total
number of cells (live and dead cells combined). See Appendix 12.8 for full protocol.

7.3. ImageJ Analysis of BioTek Cytation Images
To begin, choose the most in-focus image (figure 8a) for the desired well and upload it to

an image analysis tool named ImageJ. Measure the scale bar in the corner of the image using the
line tool and measurement feature. Set the scale under ‘Analyze’ → ‘Set Scale’ by setting the
‘distance in pixels’ to the measured amount of pixels from the images scale bar length. Then set
the known length to the scale bar length in µm, and changing the ‘Unit of length’ to read um in
order to output results in micrometers. Select the ‘Global’ box to retain the scale bar incase of
needing to restart the analysis process with an image, then select ‘OK’.

Starting image analysis, change the image type to a 16-bit under ‘Image’ → ‘Type’ →
‘16-bit’ in order to use the ‘Threshold’ feature. Next, select ‘Image’ → ‘Adjust’ → ‘Threshold’.
Uncheck the box titled ‘Dark background’ if selected, then move the ranges until the desired
section shows the spheroids highlighted in red, as seen in figure 8b, then hit ‘Apply’. Threshold
recognizes pixels containing cells, or in this case spheroids. Next, go to ‘Process’ → ‘Binary’ →
‘Watershed’, which separates any spheroids that were close together but were recognized as one
by the ‘Threshold’ feature. In order to block out any background noise from the edges of the well
use the ellipse tool to encircle only the center of the well being analyzed (Figure 8c).

To analyze the highlighted spheroids click ‘Analyze’ → ‘Analyze Particles’. Set the size
range to 4147-infinity, as to ensure only spheroids of 20 or more cells were being analyzed. In
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the dropdown menu under ‘Show:’ select ‘Outlines’ then underneath select the ‘Display results’,
‘Clear results’, and ‘Exclude on edges’ boxes before hitting ‘OK’ (Figure 8d).

To save the results one of two windows will pop up. 1. A window asking to save
measurements or 2. A results window. Should option 1 appear, select save measurements, but if
option 2 appears, select ‘File’ → ‘Save As’ then save results as an excel file to a secure and
known location. Combine the excel files into one master document for data analysis.

A B

C D
Figure 8: A. Initial image of well G1 from BioTek Cytation imager B. Threshold applied to image
C. Binary→Watershed applied to the image with a thin yellow ellipse enclosing the well space D.

Outlines of all spheroids analyzed for well G1

7.4. qPCR for Stemness Markers
This protocol was developed by Hess Lab [89]. A quantitative polymerase chain reaction

(qPCR) will be performed to test for the expression level of stemness marker genes indicative of
spheroid formation. For the purposes of this project, SOX2 and KLF4 will be the marker genes
selected due to their association and upregulation in A549 spheroid cells [9].

First, RNA is extracted using the Qiagen RNAeasy Kit. cDNA template is then
synthesized using extracted RNA. Primers for gene(s) of interest are designed, along with
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preparing a loading control primer. qPCR is then performed using the Taqman method. CT
values obtained for experimental samples compared to control are analyzed to determine if the
expression of gene(s) of interest has been perturbed. See Appendix 12.11 for detailed protocol.

8. Results
The results from the ImageJ analysis were compiled into one master document to further

analyze. The average number of spheroids per density and the average spheroid size per density
were taken.

First the average spheroid size per density was taken by averaging all the data from the
six wells of each density. There appeared to be no apparent correlation between size and density
as the average was 5675, 8558, 6301, and 9232 µm2 for 25k, 50k, 75k, and 150k cells/cm2

respectively.

Figure 9: Average Spheroid Size per Density
Secondly, the average number of spheroids per density was taken by once again

averaging all the data from the six wells of each density. There appeared to be a positive
correlation between an increase of spheroid number to an increase in density. The average were
4, 23, 39, and 60 spheroids for 25k, 50k, 75k, and 150k cells/cm2 respectively.

Figure 10: Average Number of Spheroids per Density.
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9. Discussion
The passaging protocol for A549 cells was optimized to reflect the established doubling

time of approximately 23 hours. This optimization ensured consistent cell viability and growth,
avoiding over-confluence that could disrupt spheroid formation and cellular responses. By
implementing a schedule of one passage every 48-72 hours, the team maintained cellular
integrity, aligning with literature values and reducing variability caused by inconsistent handling.
During the spheroid formation process, the results demonstrated a linear increase in spheroid
number with seeding density. The average spheroid size remained within the 50–800 µm
diameter range reported in the literature. Towards the end of the semester, the team could have
made more spheroids to further back the results seen in figure 10, but issues with the CytoFLEX
led to a change in plans. Next semester a repeat trial of seeding density variations using a
live/dead cytometry assay will confirm the preliminary findings regarding spheroid viability and
optimal seeding conditions. Additionally, in creating uniform spheroids, the methylcellulose
concentration for each well is then considered optimized.

While the team was successful in creating spheroids, performing qPCR for SOX2 will
have to be done next semester. It is hypothesized that gene expression differences are to be seen
when comparing 3D spheroids and 2D monolayer cultures, with the idea that a 3D model is
better at mimicking in vivo tumor microenvironments. SOX2 amplifies the ability of cancer cells
to sustain growth and resist apoptosis, which is why it is a significant measurement of
tumorigenicity. The SOX2 qPCR would provide valuable information pre-CRISPRi screen. For
instance, the CRISPRi screen could knockdown a gene such as SOX2, allowing for repression at
the transcriptional level to see how the gene played a role in growth and survival. The more
favorable a gene is, the more DNA damage will be seen due to its repression. While in hindsight
this process seems to be moving in the right direction, there is currently no data on CRISPRi
screening within a A549 spheroid model, which leaves the results and processes involved open
to discussion.

Lastly, the final future work aspect of this project involves testing the processes of
dissociation, staining, and fixing the spheroid cells for γH2AX. This will help determine how the
specific genes targeted respond to the repression from a CRISPRi screen. γH2AX is a marker for
DSBs, which will either be increased or decreased as a result of gene repression. DSBs are one
of the more severe forms of DNA damage, where both DNA helix strands are broken
simultaneously. These breaks can be the result in many cases from ionizing radiation, reactive
oxygen species, or chemotherapeutic agents for cancer treatment. By utilizing γH2AX staining in
a 3D environment, more accurate predictions can be made about what genes contribute to tumor
progression and metastasis. The goal is to refine these methods and achieve these significant
milestones by May 2025.
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10. Conclusions
This semester the team was able to select a viable adenocarcinoma non-small cell lung

cancer cell line: A549. The cell line was chosen based on characteristics such as: doubling time,
adherence properties, and key tumor protein 53 mutation. The cell line was maintained and
counted to stay at a consistent 60-80% confluency, which for A549 cells is 3 to 4 million cells
per vial. For spheroid formation, poly-HEMA treated plates were chosen due to their
cost-effectiveness and ability to produce a consistent size and shape of spheroids. The
crosslinking of poly-HEMA prevents cell attachment and promotes cell-cell aggregation into 3D
spheroids that are better at mimicking an in vivo environment than a traditional 2D structure.
Current research has an optimal spheroid size for the A549 cell line around 500μm, so testing
data from next semester will be used to compare against this value. By optimizing a spheroid
formation protocol, the team will be able to begin working on a γH2AX staining protocol at the
beginning of next semester.
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12. Appendix
12.1. Product Design Specifications

Created: September 19, 2024

Function: Although previous CRISPRi screening in 2D monolayers has provided useful
knowledge on cancer drivers and therapeutic susceptibilities, it lacks an element of biological
relevance to an in vivo environment. Therefore, our team was tasked with developing a cell
culture method that is compatible with a 3D environment and CRISPRi screening in order to
identify sources of DNA mutations in the tumor environment. On a high scale, the team must
select a viable cell line for the screen, create and optimize a spheroid formation protocol, and
develop a protocol to stain for γH2AX: a histone variant that acts as a sensitive marker for
DNA damage.

Client requirements:
1. The team must choose an appropriate human cell line for the project, ensuring to

maximize cell spheroid viability.
2. The team must develop a spheroid formation protocol for the chosen cell type or line that

optimizes seeding density and viscosity.
3. The team must optimize the cancer spheroid characteristics and their formation protocols

for CRISPR screens.
4. By May 2025, the team must develop a protocol to stain for 𝛾H2AX: an indicator for the

location of maximal damage due to DNA double-strand breaks (DSBs).
5. By May 2025, the team must perform high throughput genome-wide CRISPR screening

to check for the effects of different genes on the amount of 𝛾H2AX detected.
6. Future steps post-design project include performing an analysis to determine the

phenotypic differences between cells grown in monolayers (2D) versus cells grown as
spheroids (3D).

Design requirements:
1. Physical and Operational Characteristics

a. Performance requirements:
i. Spheroid formation protocol should be scalable, repeatable, and optimized

regarding:
1. Seeding densities to ensure only 1 single guide (sgRNA) will enter

each cell.
2. Viscosity of growth medium (by changing the amount of

methylcellulose) to ensure homogenous spheroid size.
3. Optimizing reagent percentages of growth medium to ensure

maximum cell growth.
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ii. γH2AX staining protocol should be scalable, repeatable and optimized
regarding the antibody used and amount of reagents used.

b. Safety:
i. Biosafety Level 2 (BSL-2) is necessary for work with agents associated

with human tissue and disease including the human lung cancer cell line
which the team will be using [1]. The following universal precautions for
BSL-2 are used to reduce the risk of bloodborne pathogens:

1. Laboratory personnel receive specific training in handling
pathogenic agents and are supervised by scientists competent in
handling infectious agents and associated procedures [1].

2. Access to the laboratory is restricted when work is being
conducted [1].

3. All procedures in which infectious aerosols or splashes may be
created are conducted in BSCs or other physical containment
equipment [1].

ii. Cultures, tissues, specimens of body fluids, or potentially infectious
wastes are to be placed in a container with a cover that prevents leakage
during handling, processing, and storage [2].

iii. Although the team does not anticipate the need to remove our cells or
cancer spheroids from Hess Lab, the following BSL-2 guideline must be
followed.

1. Biological agents prepared for transport must be placed in a
secondary leak-proof, unbreakable carrier. Carriers must have the
biohazard label, including the identity of the agent, affixed to the
outer surface of the transport container [2].

iv. If genome editing leads to the inactivation of tumor suppressors or
activation of oncogenes in human cells, then oncogenesis becomes a
possibility in the event of exposure [3]. This is a concern when:

1. Genome editing components are delivered by a method that can
enter human cells (e.g., viral vectors that can infect human cells).

2. All components required for genome editing are likely to be
introduced in a single exposure event, such as a needle stick or
mucosal splash.

3. Genome editing is designed to target human oncogenes/tumor
suppressors or can target human oncogenes/tumor suppressors due
to homology.

v. A risk assessment and containment preparations for research with
lentiviral vectors should consider (1) the nature of the vector system, (2)
transgene insert, and (3) type of manipulations involved [4]. Either BL-2

37



or enhanced BL-2 will be appropriate for these such experiments. The
major risks to be considered for research with HIV-1 based lentivirus
vectors are (1) potential for generation of replication-competent lentivirus
(RCL) and (2) potential for oncogenesis [4]. These risks can be mitigated
by the nature of the vector system (and its safety features) or exacerbated
by the nature of the transgene insert encoded by the vector [4].

c. Accuracy and Reliability:
i. A starting cell seeding density of 50,000 cells/cm² will be used. Cells at

these densities will be monitored for growth and death rates on a live-cell
microscope for 60 hours to confirm a ~30% cell death rate during the
initial growth phase of the spheroids [5].

ii. Cell seeding densities must be such that only 1 single guide (sgRNA)
enters each cell to allow for analyzable results. Therefore, a total of
100-150 million cells will be required for each genome-wide CRISPR
screen [6].

iii. A minimum of 3 𝛾-H2AX staining experiments will be performed to
establish confidence in results.

d. Life in Service:
i. Before preparing them for CRISPRi screening, cells will need to be in

culture for approximately 2 months to allow for optimization of the
spheroid formation protocol, including the spheroids’ size and cell
quantity. This time period may consist of thawing a new vial of cells for
continuing cell culture if the passage number exceeds 25 [7].

ii. After infection with the selected genome-wide library, a minimum of 6
days will be required before the cells can be further utilized [5].

iii. After generating spheroids from these cells, a minimum of 21 days will be
required for the genome-wide screening [5].

e. Shelf Life:
i. When not in culture or experimental use, cells will be stored using

cryogenics for long-term use. Frozen cells will be kept in cryovials with
medium containing a cryoprotective agent like DMSO. These vials will be
immersed in liquid nitrogen at a temperature below -135℃ [8].

f. Operating Environment:
i. Cells needed to generate spheroids for this project will be kept in standard

incubation conditions: 37℃, 5% CO₂, and 90–95% relative humidity [9].

38



ii. Cells in culture will be maintained in a cell culture medium supplemented
with fetal calf/bovine serum to deliver essential growth factors. The
medium will contain phenol red, which will indicate the need to replace it
if it turns yellow (acidic) or purple (alkaline) [9].

iii. For preparation for CRISPRi screening, spheroid cells will be exposed to a
pooled single-guide RNA (sgRNA) library and CRISPR associated protein
9 (Cas9) via lentiviral vectors [10].

g. Ergonomics:
i. Protocols should create a more efficient and accurate experimental system

that better mimics in vivo tumor conditions, while proving the effects of
γH2AX in DNA damage.

ii. The design of cell culture methods should be optimized by selecting
appropriate cell lines and developing correct spheroid formations to
enhance the accuracy, relevance, and scalability of CRISPRi screening in
a 3D tumor model.

iii. The γH2AX staining protocol should be optimized for improved
precision. Additionally, γH2AX foci counting should be performed via
high-throughput screening for efficiency.

h. Size:
i. Spheroids will be generated in 60 mm tissue culture plates [5].
ii. Cell seeding density for spheroids will be restricted to 50,000 cells/cm² to

ensure appropriate CRISPRi screening [5].
iii. To adhere to a spheroid size suitable for 𝛾H2AX staining, spheroids will

be kept to ~500 µm in diameter [11].

i. Weight:
i. Although solutions have been presented for single-cell analysis, literature

does not cover this aspect for 3D models such as spheroids [12]. Tools
like a flow-apparatus are needed for the accurate measurements of mass
density, size and weight of such spheroids [12].

j. Materials:
i. In order to leave room for the engineering design element, the client did

not give specific requirements for materials other than cell type to be used
for the project.

ii. The client has recommended that the team select a human lung cancer cell
line that (1) adheres well to spheroids and (2) has a high percentage of
viable cells.
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k. Appearance:
i. Since the spheroids should have an overall appearance that will accurately

replicate the 3D tumor microenvironment, the spheroids must be:
translucent, porous, uniformly spherical, and have a stiffness analogous to
the lung cancer cell line selected [13].

2. Production Characteristics
a. Quantity:

i. By the end of this semester, the team will design, fabricate, and develop
two appropriate protocols for the chosen cell line, one for spheroid
formation and one for γH2AX.

ii. The final protocols should be capable of accurately mimicking the 3D
tumor environment for CRISPR screening, including features for effective
spheroid formation and reliable γH2AX staining to assess DNA changes.

iii. The protocols can be adapted to other similar human cancer cell lines;
however, some of the characteristics may be subjected to change.

b. Target Product Cost:
i. The budget for the project is $1,000. Some of the materials and services

that the team expects to use are listed below; however, many are already
available in Hess Lab and will not need to be purchased.

1. Biological materials such as reagents (for various media),
antibodies (for γH2AX staining) and lentivirus for gene insertion.

2. Obtaining new cell lines if needed.
3. Designing of CRISPR library.

ii. This project is a part of an emerging field, so similar products on the
market are not available for non-clinical purchasing purposes. Therefore,
the target cost of the final prototype is to remain within the budget
proposed.

3. Miscellaneous
a. Standards and Specifications:

i. Cell lines used for this project should comply with the requirements
outlined in part 1b - Safety above. Specifically, cell lines used and their
associated reagents and protocols will need to comply with requirements
for BSL-2 labs; meaning, they are or will contain bacteria, viruses, and
organisms that pose a moderate safety hazard to healthy adult humans
[14].
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ii. The use of human cell lines and other organisms in research for this
project is outlined in various standards and regulations including Section
29 CFR 1910.1030 (OSHA Bloodborne Pathogens), Section 21 CFR
876.5885 (Tissue culture media for human ex vivo tissue and cell culture
processing applications), and a comprehensive cell line guideline by
Geraughty, et al (2014):

1. Bloodborne pathogens are microorganisms in the blood that can
infect and cause diseases in humans [15].

2. Human cell lines are designated by the FDA as Class II (Special
Controls) [16].

3. If applicable, genetic modification processes on the cell line must
be detailedly-noted and kept track of, including but not limited to,
sequence details, insertion vectors and modes, and antibiotic
resistance markers [17]. Following modification using lentivirus,
cell lines may be additionally tested to confirm non-infectivity
[17].

iii. Human cell lines that may be needed for this project are already available
in the client’s lab, or can be obtained from another lab, meaning they
already comply with the requirements listed above. In the case that
biological research materials are obtained from another lab or institute, an
MTA (material-transfer agreements) must be signed by both the provider
and recipient to define their rights regarding the materials [17].

iv. In the unlikely case that new human cell lines must be acquired, additional
ethical and authentication considerations must be taken into account:

1. Ethical considerations are outlined in Part 3c - Patient-related
concerns below.

2. For cell line authentication, short tandem repeat (STR) is the
recommended profiling method, outlined in ASN-0002
(Authentication of Human Cell Lines: Standardization of STR
Profiling) provided by the American National Standards Institute
(ANSI) and the American Type Culture Collection (ATCC). STR is
a DNA-based sequence method that allows for detection of
mutations and adventitious agents, as well as confirmation of the
origin of the interested cell line [18].

b. Patient-related concerns:
i. As cell lines and other tissue materials needed for this project are either

already available in the client’s lab or in another lab, their ethical and other
patient-related considerations have already been considered.
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ii. In the unlikely case that a new cell line is obtained from patients or
donors, the Patient Consent Form and associated Patient Information Sheet
will be needed to explain the need for the specimen and the purpose and
importance of the research [17]. Patient/donor and original tissue
information such as age, sex, clinical history, site of origin, nature of tissue
specimen, stage and grade of cancer or other disease/ pathology, and other
important information must also be recorded.

iii. For maximal biological relevance to patient in vivo tissue, the team will
ensure our spheroids are designed based on critical 3D parameters:
stiffness analogous to lung cancer tissue, replication of the complex
cell-cell interactions and cell-extracellular matrix (ECM) interactions, and
increased accuracy in CRISPRi screening environment to better detect
precancerous cells [19], [20].

c. Competition:
i. 3D cancer spheroid models that can be utilized for CRISPR-Cas9 screens

have been implemented in previous research, with and without using an
exogenous extracellular matrix (ECM).

1. Takahashi et al, 2020 utilized 4% Matrigel™ as a bio-scaffolding
to plate A549 and H1437 cells spheroids, which can better model
in-vivo interactions between cells and the ECM [21]. The study’s
CRISPRi library gene list as well as its phenotypes have a strong
overlap with those from Han et al, 2020 (described below),
suggesting that inner cells of ECM-based 3D spheroids may be
similar to ECM-free 3D spheroids.

2. Han et al, 2020 devised an ECM-free scalable method to propagate
3D spheroids [5]. H23 cells were seeded on pre-treated ultra-low
attachment or poly-HEMA-covered plates in RPMI 1640 medium
with 0.75% methylcellulose. Similar methods have been found to
be implemented in other studies, such as by Ferrarone, et al (2024)
and by Stiff, et al (2024) [22], [23]. A total of around 210,000
single guide RNAs (sgRNAs) were designed for the CRISPRi
library with around 10 sgRNAs per gene [5]. Samples were used to
calculate growth and/or tested for drug resistance [5].

3. 3D stem cell models have also been genomically edited via
CRISPR-Cas9 to better model various disease phenotypes. Cells
can be assembled with or without supporting scaffolds. Some
example scaffolds include laminin-rich Matrigel, collagen matrix,
or those that are naturally derived from decellularized tissues [24].
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ii. 𝛾H2AX has been used in various research as a marker to monitor DNA
damage and repair, such as in understanding the toxicity of cigarette
smoke or in understanding the effects of chemotherapeutic treatments in
cancer patients [25], [26]. High throughput systems have also been
developed to aid with counting 𝛾H2AX foci [26].
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12.2. Hess Cell Line Maintenance Protocol

Thawing

1) Prepare 10mL of the appropriate media in a 15ml tube.
2) Using a P1000 slowly mix the media in the cryovial to thaw the pellet of cells.
3) Set the pipette to something below 1000uL, maybe 900uL to avoid clogging the filter

while resuspending
4) Once thawed, add to the remaining media and spin down at 1400 rpm for 5 min.
5) Resuspend the cells in fresh media and add to a flask to incubate for typically 3 days

before passaging further.

Passaging Adherent (eg. A549) Cell Line

1) This assumes passaging in a T75 flask, if using a T150, double the volumes)
2) Remove all media with Pasteur pipette and vacuum
3) Add 2ml of PBS to remove remaining media and remove with vacuum
4) Add 2mL trypsin and wait five min at 37C
5) Add 6mL media to neutralize trypsin while mixing to remove cells from the

bottom of the flask (at least 3x the volume of trypsin used)
6) Wash the flask with the cells in media, remove and add to a 15ml conical tube
7) Return enough media to the flask so cells will be confluent when next checked
8) Add additional media (eg. 10 ml)
9) The media just needs to be enough to cover the cells, provide nutrients and won't

dry out. Adding more media doesn't change the confluence of the cells.

Counting Cells

10)Add 100uL of cells in media to 900ul PBS in a microcentrifuge tube.
11) This may not be necessary for less confluent cells, but highly dense cells,

especially adherent cells, tend to clump together and throw off the count.
12)Measure 10uL on the cytometer and gate for the live population of cells
13)Use the "live" number of events to calculate the confluence and total number of

cells you have.
14) Since the cells have been diluted 1:10, the "live" events gives you the number of

cells per uL, multiply this by 1000 to get the number of cells per mL.
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12.3. CytoFLEX Operation

Once the CytoFLEX and its corresponding computer have been turned on, the following steps
must be followed:

1) In the top left click Cytometer > Daily clean
a) Load Blue tube and press run (3 minutes)
b) Load DI water and press run (1 minute)

2) To create a new experiment click file> new> from template>Browse
a) Click into BME Team cell counting file on computer drive

Documents>CytoFLEX>BME Team
3) Name file after current date and passage number
4) Vortex sample
5) Uncap sample in 1 mL Eppendorf container and place in CytoFLEX
6) Select fast in settings on left side
7) Click record
8) Once a dot plot of the events has been created right click on the plot>properties

a) Auto set x-axis
b) Auto set y-axis

9) Right click on graph and select polygon tool
10)Gate the cells in a oblong hexagon fashion trying to bin all relevant events (general note:

live cells are larger than dead cells)
11) Save file
12) Rerun daily clean (step 1)
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12.4. Benchling Confluency Tracker
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12.5. Spheroid formation protocol
12.5.a. Methylcellulose Stock Solution Preparation

Materials:
● 2 g Methylcellulose
● 100 mL deionized water (diH₂O)
● 1x beaker that can hold 100 mL
● 1x heated stirrer plate
● 1x magnetic stir bar
● 1x 500 mL glass bottle with screw cap

Steps:
● Add stir bar into glass bottle
● Add methylcellulose and diH₂O into glass bottle
● Mix solution at 80°C until homogeneous
● Autoclave solution using Liquid 2 (L2) setting with screw cap loose
● Move solution into walk-in fridge and mix overnight at 4°C
● Keep solution at 4°C until needed

12.5.b. Poly-HEMA Stock Solution Preparation
Materials

● 1.3 g poly-HEMA
● 33 mL 99% ethanol
● 1x beaker that can hold 33 mL
● 1x heated stirrer plate
● 1x magnetic stir bar
● 1x 0.2 µm filter (Nalgene) or something similar
● 1x 250 mL glass bottle with screw cap

Steps:
● Add poly-HEMA to 99% ethanol
● Mix solution overnight at 37°C
● Filter solution into glass bottle
● Keep solution at 20°C (room temperature) until needed
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12.5.c. Cell Seeding
Materials:

● Methylcellulose stock solution
● Poly-HEMA stock solution
● Cells collected after passaging
● Serum-free DMEM
● 15 mL conical tubes
● Eppendorf tubes
● 96-well plates

Procedure:
1) Collect cells from that day's passage and obtain cell concentration using the CytoFLEX to

obtain cell concentration (cells/mL).
2) Obtain a 1.5 mL cell solution of 500,000 cells/mL (750,000 cells in total)

a) Volume needed to obtain 750,000 cells: 750,000 (cells) / cell concentration from
CytoFLEX (Step 1, cells/mL)

b) Obtain the volume calculated from the T75 flask and transfer into a 15 mL conical
tube.

c) Spin down the the tube at 200g for 5 minutes, then remove supernatant to collect
cells using vacuum filter

d) Resuspend cells in 1.5 mL of serum-free DMEM.
3) Prepare master mix of cell solutions for spheroid formation for 4 different densities. The

master mix can be used for 6 wells in a 96-well plate and can be scaled to adjust for
different numbers of wells if needed.

a) Density 1: 25,000 cells/cm2

i) Into a new 1.5 mL eppendorf tube, add:
(1) 100 µL of 500,000 cells/mL cell solution (Step 2)
(2) 525 µL of serum-free DMEM
(3) 375 µL of 2% methylcellulose stock

ii) Mix gently by pipetting up and down, make sure the solution is
well-mixed

b) Density 2: 50,000 cells/cm2

i) Into a new 1.5 mL eppendorf tube, add:
(1) 200 µL of 500,000 cells/mL cell solution (Step 2)
(2) 425 µL of serum-free DMEM
(3) 375 µL of 2% methylcellulose stock

ii) Mix gently by pipetting up and down, make sure the solution is
well-mixed

c) Density 3: 75,000 cells/cm2

i) Into a new 1.5 mL eppendorf tube, add:
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(1) 300 µL of 500,000 cells/mL cell solution (Step 2)
(2) 325 µL of serum-free DMEM
(3) 375 µL of 2% methylcellulose stock

ii) Mix gently by pipetting up and down, make sure the solution is
well-mixed

d) Density 4: 150,000 cells/cm2

i) Into a new 1.5 mL eppendorf tube, add:
(1) 600 µL of 500,000 cells/mL cell solution (Step 2)
(2) 25 µL of serum-free DMEM
(3) 375 µL of 2% methylcellulose stock

ii) Mix gently by pipetting up and down, make sure the solution is
well-mixed

4) Aliquot the prepared master mix into each well: add 160 µL of cell mixture into each
well.

5) Grow spheroids in 37C, 5% CO2 incubator. Spheroids are split every 3-4 days.
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12.6. BioTek Cytation Imaging Protocol
1. Turn on and sign in to BioSpa associated computer.
2. Open BioTek Gen5 3.14 application
3. Place plate in BioTek like in the following image, make sure that the A1 well is on the

bottom right of the holder.

a.
4. Select new experiment and new protocol

a. Name with experiment type and date
5. Set protocol procedure

a. Set temperature to 37°C
b. Middle imaging (images taken from middle of well)
c. Deselect auto exposure
d. Choose plate type: Falcon® 96-well flat-bottom 300 μL

6. Imaging settings
a. 4x magnification
b. Brightfield
c. FVOW

7. Click microscope image
a. Find well and click auto exposure
b. For z-stack: set focus distance from bottom
c. Set z-stack = 5, distance = 80 μm
d. Select which wells to image

8. Save images and experiment directly to computer
a. Save > Options > save options > experiment > images
b. This PC > Users > Public > documents > protocol > Hess lab > BME Team
c. This PC > Users > Public > documents > experiment > Hess lab > BME Team

9. Run experiment trial by clicking “play” button
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Please note:
● Experiments and photos must be saved in the same location and transferred together

otherwise both will be lost.
● Complete set up and run takes around 30 minutes for 24 wells.

12.7. Spheroid Dissociation
Materials

● Eppendorf tubes
● P200, P1000 pipettes, 15 mL serological pipets
● Accutase
● Full DMEM (DMEM + 10% FBS + 1% Pen/Strep)
● Formed spheroids (see Appendix 12.5)

Protocols:
1. Prepare 24 eppendorf 1.5 mL tubes (for dissociation of 24 wells). Label them

accordingly.
2. Transfer the media (with cancer spheroids inside) from the wells into the according

eppendorf 1.5 mL tubes using a 15 mL serological pipet.
3. To each eppendorf 1.5 mL tube, add 480 µL of PBS.
4. Pellet the spheroids via centrifugation at 800g, 15 min, then remove the supernatant using

a pasteur pipet.
5. Resuspend the pellets in 150 μL Accutase using a P200 pipette. Thoroughly mix the

solution by pipetting up and down 10 times using a P200 pipette set to 100 μL.
6. Incubate the tubes in 37°C for 10 minutes.
7. Pipette the solution in each tube up and down 10 times using a P200 pipette set to 100

μL.
8. Add 850 μL of DMEM so that the final volume reaches 1 mL.
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12.8. Percent Viability after Spheroid Formation Determination
Materials

● Eppendorf tubes of 1 mL dissociated cells from spheroids (see Appendix 12.7)
● Cytoflex machine

Protocols:
1. Run the Cytoflex for each tube (see Appendix 12.6).
2. Gate (/draw polygon) areas where there are alive cells, record the number shown on the

screen.
a. Cell concentration = number shown on screen * 10,000 (cells/mL)
b. Total number of live cells = cell concentration (cells/mL) * 1 mL (volume in

eppendorf tube)
3. Gate (/draw polygon) areas where there are dead cells (smaller scatter than live cells),

record the number shown on the screen.
a. Cell concentration = number shown on screen * 10,000 (cells/mL)
b. Total number of dead cells = cell concentration (cells/mL) * 1 mL (volume in

eppendorf tube)
4. Calculate percent viability: total number of live cells / (total number of live cells + total

number of dead cells) * 100%

12.9. Lentiviral infection protocol
Small scale infection of mammalian cells with Lentivirus: Adherent Cells Version

Materials:
● ThermoFisher cell culture numbers for adherent cells:
● https://www.thermofisher.com/us/en/home/references/gibco-cell-culture-basics/cell-cultur

e-protocols/cell-culture-useful-numbers.html

Infection Procedure:
Cell Line # of cells (24 Well)
293T 50,000
HeLa 20,000
HAP1 20,000

1) Count and plate the # of cells listed above for each infection in a well of a 24 well plate.
(If you want to plate the cells the day before, plate half as many as listed above)

2) Sterile filter with 1 0.45µm filter. Add 1-2 mL of virus(es) to each well and leave to
incubate for 24 hours at 37C.

3) After incubating, aspirate the viral media from each well. Add 1 mL of proper media to
the cells.
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4) 48-72 hours later, the cells should be ready for analysis by fluorescence or selection with
antibiotic.
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12.10. High-throughput CRISPR screen protocol

This protocol was originally written for use with HuH7 and U-2 OS cells. However, the protocol
steps to test dose-response cytotoxicity can be applied to any cell type, including A549 cells
which will be used for our project.

Materials: See “key resources” table in protocol [1] for a more detailed description of necessary
reagents for the CRISPR screening process.

Procedure:

12.10.a. Generate Cas9-Expressing Cells

The Cas9 endonuclease and targeting sgRNAs can be introduced together or separately through
lentiviral transduction. This integrates Cas9 and sgRNAs non-specifically into the genome,
which is appropriate for almost all CRISPR screens in immortalized cells. Through this protocol,
constitutive Cas9 expression is induced through lentiviral transduction. Cas9 is then stably
expressed and remains active throughout the screening process.

1) Plate 300,000 HEK293T cells into one well of a 6-well culture plate in 1 mL DMEM +
10% FBS such that they are at ∼50% confluence 24 h later.

2) After 24 h, transfect HEK293T cells with Mirus LT1 transfection reagent, 500 ng 3rd
generation lentiviral packaging vector mix (equal parts pMDLg/pRRE [Addgene #
12251], pRSV-Rev [Addgene # 12253], and pMV2.g [Addgene # 12259]), and 500 ng
pLenti-Cas9-blast (Addgene # 52962) at a 3:1 Mirus:DNA ratio. Follow Mirus Bio’s
“TransIT-LT1 Full Transfection Protocol” [2].

Critical: To ensure sufficient viral titers are reached, all library and packaging
plasmids should be endotoxin-free and the packaging HEK293T cells need to be
healthy prior to transfection.

3) Incubate cells for 72 h.
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4) After 72 h, collect viral supernatant through a 0.45 μm filter. Use immediately or store at
4°C for up to one week or −80°C for up to six months.

Critical:When working with lentivirus, bleach all media and supplies and turn on
ultraviolet light in the biosafety cabinet for thirty minutes to inactivate viral
particles.

5) Plate 100,000 HuH7 cells into two wells of a 6-well tissue culture plate in DMEM + 10%
FBS such that cells are at ∼80% confluence 24 h later.

6) After 24 h, introduce 0.5 mL fresh DMEM + 10% FBS and 0.5 mL pLenti-Cas9-blast
lentivirus-containing medium to the cells in one well with 8 μg/mL polybrene. Incubate
for 24 h.

Note: Keep one well uninfected as a control for the antibiotic selection.

7) After 24 h, remove viral media and replace with DMEM + 10% FBS.
a) Expand cells for 24 h and then begin antibiotic selection with 4 μg/mL blasticidin.

Note:With the amount of lentivirus added in step 6, ∼30%–50% of cells
should be infected. Cells can therefore start selection at high confluency
and not overgrow the plate.

b) Replace the selection media every 3–4 days and split cells as necessary until all
control cells have died.

Note: The concentration of selection antibiotic is dependent on the cell
line. This concentration should be determined in advance with antibiotic
kill curves.

8) Once all control cells have died, replace media for Cas9 cells with fresh DMEM + 10%
FBS without antibiotics to allow cells to recover. These are now your “Cas9” cells.

Note: Cas9 pools or clonal cells can be used for CRISPR screening. To avoid
clonal bias from the genetic background, this protocol calls for screening pools of
Cas9 cells and does not select monoclonal cells.

9) Validate Cas9 expression by Western blot.
10) Freeze cells at −80°C and store in liquid nitrogen.

Note: It is useful to expand these cells and store in excess since they can be used
for subsequent screens or individual gene knockouts.

Note: After introduction into cells, it is important to make sure that Cas9 is active
(steps 11-16). To test Cas9 activity, independently infect cells with a lentiviral
plasmid encoding: 1. mCherry plus a non-targeting sgRNA (control) and 2.
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mCherry plus an mCherry-targeting sgRNA. Employ flow cytometry to measure
mCherry expression. Cells expressing active Cas9 will cleave the mCherry DNA
and appear as an mCherry negative population. Conversely, cells lacking active
Cas9 will fail to cleave the mCherry DNA and appear as an mCherry positive
population. Due to the long half-life of mCherry, it may take up to 1–2 weeks to
distinguish the active Cas9 (e.g., mCherry-negative) cells.

11) Repeat steps 1–4 to make lentiviral media containing a control sgRNA or
mCherry-targeting sgRNA (see “key resources” table [1] for sequences) cloned into
pMCB320 lentiviral vector (Addgene # 89359).

12) Plate 100,000 HuH7 Cas9 cells into three wells of a 6-well plate in DMEM + 10% FBS
so that cells reach ∼80% confluence 24 h later.

13)After 24 h, introduce viral media containing the control sgRNA or the mCherry-targeting
sgRNA cloned into the pMCB320 lentiviral vector with 8 μg/mL polybrene to two of the
wells. Incubate for 24 h.

14)After 24 h, remove viral media and replace with DMEM + 10% FBS. Expand cells for 48
h and then begin antibiotic selection with 2 μg/mL puromycin (see note above on
antibiotic concentrations). Replace the selection media every 3–4 days until all control
cells have died.

15)Once all control cells have died, replace media with fresh DMEM + 10% FBS without
antibiotics to allow cells to recover.

16)Measure mCherry fluorescence by flow cytometry to validate Cas9 activity.

12.10.b. Dose Response Analysis to Determine Concentration of Cytotoxic
Compounds

An optimal concentration of your choice compound to induce cell death is crucial to achieving
the maximum dynamic range of the screen readout. For a drug-resistance screen, a sublethal
concentration of drug that causes very modest cell death (∼5%) in 24-48 h should be determined.
Presumably, the depletion of a drug resistance factor will lead to a substantial increase in the
sensitivity to the drug, leading to a depletion of the sgRNA over time. For a drug-sensitivity
screen, an initial drug concentration that causes ∼50% cell death should be determined. However,
as pools of surviving cells from the initial selection will become resistant to cell death induced
by the drug, a slightly higher concentration may be required for each subsequent treatment cycle
to achieve ∼50% death.

Note: This is a specific example for identifying ferroptosis resistance factors using
known ferroptosis inducing compounds. However, this protocol can be extrapolated to
any treatment or condition that provides a selective pressure on cell viability.
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17)On day 0, seed ∼5,000 U-2 OS cells in each well of a 96-well plate such that the final
volume per well is 200 μL.

18)On day 1, aspirate the media from the 96 well-plate and replace it with 100 μL fresh
media.

19) Prepare a 2× final solution of the compound at varying concentrations by serial dilution
in media containing 60 nM SYTOX Green Dead Cell Stain.

Note: 8–12 different concentrations are recommended to ensure that the optimum
concentration is within the standard curve. It is recommended to begin with a
10-point, 5-fold dilution series.

20) Slowly add 100 μL compound containing media back to each well so that the final
volume of media in each well is 200 μL with 30 nM SYTOX Green Dead Cell Stain.

21)Monitor cell death using an Incucyte Live-Cell Analysis System (Essen Biosciences),
taking images every 2 h for 24–48 h total. Dead cells will be SYTOX green-positive.

22)On day 2 or 3, determine the percentage of cell death by dividing the number of dead
cells (SYTOX green-positive) by the total number of cells (visualized by phase imaging).

Note: Due to some limitations of the Incucyte system and the dramatic difference
in cell morphology, thresholding and automatically counting total cell number
using phase images can sometimes be difficult and inaccurate. Generating a cell
line that stably expresses mCherry or using a genetically encoded live-cell nuclear
marker (e.g., Incucyte Nuclight reagents) greatly improves the accuracy of the
counting for live cells.

Note: If an Incucyte Live-Cell Analysis System is not available, a CellTiter-Glo
2.0 Cell Viability Assay can be used to determine the sub-lethal dose of the drug.

23) Choose a concentration of drug that results in ∼5% cell death. Use this concentration for
the CRISPR screen.

12.10.c. Determine the Dynamic Range for Fluorescence-Based Assays

The confidence of screen results depends on the dynamic range of the fluorescence reporter. A
greater distance between the high and low fluorescence intensity bins will result in less
biological noise and will increase the confidence of positive results and reduce the occurrence of
false positives and negatives [3]. When possible, it is useful to determine the dynamic range of a
cell population using a positive control prior to screening to ensure that cells with altered
phenotypes can be accurately sorted by FACS.

Note: Fluorescence can arise from a fluorescent reporter protein or a fluorescent dye. To
obtain the highest dynamic range from a reporter protein, it may be useful to sort cells to
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obtain a population with uniform fluorescence levels. For fluorescent dyes, test multiple
concentrations and incubation times.

Note: It is important to establish the timeframe and treatment conditions before
performing the screen itself. For example, it may take several days for a genetic
perturbation or drug to produce a measurable effect on a fluorescent reporter. Cells may
also need to be differentiated or pretreated with drugs or nutrients. Therefore, optimize
conditions and establish a timeline for seeding cells, inducing genetic perturbations,
differentiating (if applicable), and treating cells, and carry it over to the screen to yield
the most robust results.

24) Choose a positive control gene (if possible) that is known to influence levels of the
fluorescent reporter. Generate a knockout cell line or treat cells with a drug targeting the
positive control protein. Confirm that the expected increase or decrease in fluorescence is
detectable by flow cytometry.

25)Measure fluorescence by flow cytometry to validate that a change in fluorescence is
detected and to determine the dynamic range of your assay.

a) In this example, HuH7 cells were treated with 1 μg/mL triacsin C or 100 μM oleic
acid to deplete or increase neutral lipid storage, respectively. Cells were treated
with 1 μg/mL BODIPY 493/503 to label neutral lipids and fluorescence was
measured by flow cytometry. The 10× decrease and 5× increase in fluorescence
intensity will be the target dynamic range of fluorescence for this CRISPR screen.

Note: Fluorescence intensity can diminish over time. Incubate cells on ice
for multiple hours (as long as the FACS sort will be) and check that
fluorescence does not change during sorting. We have not found this to be
an issue with GFP-based reporters. If necessary, cells can be fixed prior to
FACS to ensure fluorescent marker stability over time.

Note: In some cases, there are no drugs or known regulators to manipulate
or validate the system. In the absence of a positive control to validate the
fluorescence reporter, it is possible to move directly to the screen.

12.10.d. Prepare sgRNA Library

Many genome-scale and small-scale libraries are deposited on Addgene. This protocol
used the Bassik Human CRISPR Knockout Library (Addgene # 101926-101934), which is
composed of 9 sublibraries, or the custom Human Lipid Droplet and Metabolism Library
(Addgene # 191535). Each sgRNA library will need to be amplified and packaged into lentivirus.
Alternatively, pre-packaged lentivirus can be purchased directly from Addgene.
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26) Follow the Bassik Lab’s “Liquid Culture Library Plasmid Re-amp Protocol” [4].

27)Measure DNA concentration using the Qubit dsDNA HS Assay.

12.10.e. Preparing for Deep Sequencing

To identify the sgRNAs present in each cell population, genomic DNA (gDNA) is extracted from
frozen cell pellets and guide sequences are amplified by PCR.

Note: This protocol modifies the above protocol for increased yield. For the DNA
precipitation step, increase the spin time if centrifuging at a slower speed to fully
precipitate DNA. Elute with Qiagen Buffer EB (10 mM Tris-Cl, pH 8.5; Cat # 19086)
instead of Buffer AE. Spin at 4,500 × g for 5 min. Elute 2–3 times with new Buffer EB
each time (do not reload eluate).

28) Extract gDNA from cell pellets using Qiagen QIAamp DNA Blood Midi Kit (Cat #
51183) according to the manufacturer's instructions [5].

29)Measure the gDNA concentration by nanodrop. 100 μg gDNA per 20 × 10⁶ cells are
typically obtained.

30)Amplify the integrated sgRNA (PCR1) with the following reagents and reaction program:

Critical: To make sure the diversity and coverage of sgRNAs is not lost during
PCR1, multiple 100 μL PCR reactions are required for screen preparation.
Empirically, we recommend 1 PCR reaction for every 2,500 sgRNA in the
library (e.g., For a customized library that has 25,000 sgRNAs, at least 10 PCR
reactions are needed, and therefore a minimum of 100 μg gDNA is required).

Note: Although this protocol calls for 10 μg of genomic DNA per 100 μL PCR1
reaction, DNA input can be decreased to 5 μg or less if necessary.

Table 1. PCR1 reaction master mix reagents and volumes.

Reagent Volume (μL)

gDNA template (10 μg) x

Herculase II polymerase 2

oMCB_1562 (100 μM) 1

oMCB_1563 (100 μM) 1

5× Herculase buffer 20
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dNTPs (100 nM)∗ 1

ddH2O 75-x

∗25 nM per dNTP.

Table 2: PCR1 cycling conditions.

Steps Temperature Time Cycles

Initial Denaturation 98°C 2 min 1

Denaturation 98°C 30 s 18

Annealing 59.1°C 30 s

Extension 72°C 45 s

Final Extension 72°C 3 min 1

Hold 4°C ∞

Note: As the amount of genomic DNA collected from cell samples can be limited,
especially for FACS-based screens, it is highly recommended to run a single (or “pilot”)
PCR1 to ensure all conditions are correct and yield an amplified fragment.

31) Pool and mix all amplicons of the PCRs from the same gDNA sample. Add Illumina
sequencing indexes with the following reagents and reaction program:

Table 3: PCR2 reaction master mix reagents and volumes.

Reagent Volume (μL)

PCR1 Product 5

Herculase II polymerase 2

oMCB_1440 (100 μM) 0.8

oMCB_1439 (100 μM) 0.8

5× Herculase buffer 20

dNTPs (100 nM)∗ 2

ddH2O 69.4

Table 4: PCR2 cycling conditions.
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Steps Temperature Time Cycles

Initial Denaturation 98°C 2 min 1

Denaturation 98°C 30 s 20

Annealing 59.1°C 30 s

Extension 72°C 45 s

Final Extension 72°C 3 min 1

Hold 4°C ∞

Note: Though PCR1 uses 18 cycles, it was empirically determined that 20 cycles for
PCR2 resulted in the best signal-to-noise ratio.

Note: Selecting index adapters with diverse sequences for pooled libraries is
CRITICAL: for successful sequencing and data analysis. For information on how to
optimize the color balance of the index adapters see the “Index Adapters Pooling Guide”
published by Illumina.

Note: Only one 100 μL PCR2 reaction is sufficient to achieve sequencing depth.

32) Load PCR products onto 2% TBE-agarose gel.
33) Run the sample at 120 V for 50 min. Excise the brightest band.

Note: The size of the band is expected to be 280 bp but may run higher due to
overloading of the gel.

34) Purify DNA products using QiaQuick Gel Extraction Kit (Cat # 28706) according to the
manufacturer’s instructions [6].

Note:We slightly modified this protocol for increased yield. When dissolving the gel,
add 4 volumes Buffer QG instead of 3. For the DNA precipitation step, add 3 M sodium
acetate pH 5.2 at a 1:100 ratio. For the wash step, wash with Buffer PE two times instead
of once. Elute DNA in Buffer EB, not water.

35) Check DNA concentration by Qubit dsDNA HS Assay. We typically obtain 30 ng/mL DNA.
36) Verify DNA quality using a fragment analyzer. DNA fragments should run as a single band
at ∼300 bp.
37) If the DNA runs as a single band at ∼300 bp without contamination at other sizes, pool equal
amounts of DNA from each screen sample so that the final concentration is 3 nM. Send the
pooled library for deep sequencing.
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Note: The molecular weight of the DNA can be calculated based on the nucleotide
sequence.

a) 50 μL of the pooled library at 3 nM and 30 μL of the Bassik custom sequencing Illumina
sequencing primer (oMCB1672_new10gCRKO) at 100 μM are typically sent. Both are
sent in Qiagen EB (10 mM Tris, pH 8.5).

38) Analyze deep sequencing data using casTLE.
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12.11. qPCR Testing Protocol

Materials: Qiagen RNAeasy Kit
(https://www.qiagen.com/us/products/discovery-and-translational-research/dna-rna-purification/r
na-purification/total-rna/rneasy-kits?catno=74104)

Procedure:

12.11.a. RNA Extraction with Qiagen RNAeasy Kit
1) Clean bench and spray down with RNaseZap.
2) Make RLT buffer (350μL per sample) by adding β-mercaptoethanol (10μL for every 1

mL of RLT buffer) into a separate tube inside the fume hood.
3) Note: β-mercaptoethanol should be added freshly before each set of preparations.
4) Prepare 1-5 million cells and spin down at 500g for 5 minutes. Aspirate supernatant and

resuspend cells in 350μL of prepared RLT buffer.
5) Pipet cell solution onto a QiaShredder column and spin for 2 minutes at 14000 rpm.

Discard column, not flow-through!
6) Add 350μL of 70% ethanol to flowthrough. Transfer mixture to RNAeasy spin column

and spin for 30s at 10000rpm. Discard flow-through.
7) Prepare Dnase solutions by adding 10μL of DNase I stock solution to 70μL of RDD

buffer for each column. Mix well.
8) Add 80μL of DNase I + RDD mix onto the column and let sit at room temperature for 15

min.
9) Add 350μL of RW1 buffer to column and spin 30s at 10000rpm. Discard flowthrough.
10)Add 500μL of RPE buffer to column and spin 30s at 10000rpm. Discard flowthrough.
11) Add 500μL of RPE buffer to column and spin 2 minutes at 14000rpm. Discard

flowthrough.
12) Place Column into new 1.5mL tube and elute with 30-100μL of RNase-free water. Let sit

for >5 minutes and spin down for 1 minute at 10000 rpm. Nanodrop to determine
concentration.

13) Purified RNA can be stored at -80 C for 6 months, -20 C for 1 month.

12.11.b. cDNA Synthesis with RNAeasy purified RNA
1) This protocol is for 20μL/2μg of RNA protocol. Prepare in PCR tubes:

RNA (2μg) x
Oligo dT (0.5μg/μL) 2
H₂O 8-x

Note: If using a transcript specific primer, Oligo concentration should be 0.5-1 μM in final RT
reaction. I usually use 2μL of 10μM stock.
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2) Heat sample at 70°C for 5 minutes. Place heated sample on ice for 5 minutes.
3) Add 10μL of following mix:

5X AMV RT Buffer 4
10mM dNTPs 1
RNAsin 0.25
AMV RT 0.75
H₂O 4

4) Incubate at 42°C for 2 hours.
5) If going into a PCR, add 50 uL of Milli-Q-H2O and proceed to set up qPCR reaction.

12.11.c. Setting up qPCR: TaqMan Method

Note: Check out more information on TaqMan method here:
https://tools.thermofisher.com/content/sfs/manuals/cms_041280.pdf

1) Designing the experiment: For these experiments, you require a housekeeping gene as a
loading control in addition to your genes of interest. We generally order these conjugated
to VIC and our target gene conjugated to FAM.

Name Cat No.
ACTB_VIC
GAPDH_VIC

a) There are a number of ways to set up this experiment. You can use the ΔΔCT

calculation. This works since the primer sets have been properly optimized.
Alternatively, you can set up the experiment as described in the for SYBR Green.
You will need the following samples. where you will need the following controls.

Experimental sample is measured at 1:10 dilution in quadruplicate with gene
expression assay and housekeeping gene (both are in a single well)

Note: these are only if you are making a standard curve:

Primer curve of control template to be done (1 well each dilution) for each
primer set consisting of:

No dilution
1:5 dilution
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1:25 dilution
1:125 dilution
1:625 dilution
1:3125 dilution
Empty sample

2) Setup the Following Master Mix.

Reagent 1
X

5X

20X Taq Man Gene Expression Assay Target Gene 1 5
20X Taq Man Gene Expression Assay Housekeeping
Gene

1 5

2x Taq Gene Expression Master Mix 10 50
cDNA Template (1:10 dilution) 4 20
RNAse Free water 4 20

20 100

3) Put these 20 uL reaction into a 96 well plate.
4) Setup the following protocol:

95ºC 10min
95ºC 15s
60ºC 60s
plate read
Go to 2 39 times

5) Analysis: Use the relative quantification (ΔΔCt ) method to analyze results. The general
guidelines for analysis include:

a) View the amplification plot; then, if needed:
i) Adjust the baseline and threshold values.
ii) Remove outliers from the analysis.

b) In the well table or results table, view the Ct values for each well and for each
replicate group.

c) Perform additional data analysis using any of the following software:
i) Relative Quantification application thermofisher.com/connect
ii) ExpressionSuite™ Software[1] thermofisher.com/expressionsuite
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